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Sommario

L’obiettivo é realizzare semplici programmi per introdurre e spiegare alcune problematiche tipiche delle
FPGA. 1l linguaggio di programmazione scelto per gli esempi ¢ il Verilog HDL; "ambiente di sviluppo ¢
ALTERA Quartus II WEB EDITION ver. 13.0.1 per Linux e il target € la scheda TERAsic DEO-NaNo.

Gli argomenti trattati mirano a mostrare le problematiche relative al parallelismo, al clocking e alla
simulazione RTL e Gate-Level dei circuiti.

La scelta delle FPGA ALTERA é dettata semplicemente dal fatto che i tool di sviluppo sono identici tra
le versioni Linux e Windows oltre al fatto che la scheda di sviluppo fornita da TERASIC & probabilmente la
meno costosa al momento in cui si scrive. In ultimo, non per importanza, vi ¢ il fatto che ALTERA fornisce
una vastissima quanto completa documentazione. A parte questo, non verranno fatte altre considerazioni
di merito sulla qualita dei componenti; anzi si invita chi legge ad informarsi relativamente alle soluzioni dei
competitor come XILINX, Lactice, ecc per capire quale casa offre le soluzioni migliori per i propri progetti.

Questo documento non é una guida ne completa ne esaustiva dei temi e dei linguaggi trattati, ma é solo
un’introduzione all’argomento orientata agli studenti dell’ITIS E. Fermi di Mantova. Questo documento e
il software descritto sono liberamente scaricabili dal sito dell’associazione LUGMAN www.lugman.org.

1 Introduzione al’ambiente di sviluppo

Quartus II & V'IDE di sviluppo per dispositivi ALTERA scaricabile gratuitamente (previa registrazione) dal
sito www.altera.com. La versione Web é quella completamente gratuita che mette a disposizione comunque un
certo numero di IP' pronte all’uso che vanno dai PLL ai controller per le ram DDR.

Quartus IT avviato si presenta come in figura 1.1. Di seguito verra mostrato come creare un progetto per
I’FPGA montata su DE0-Nano, ossia la Cyclon IV E EP4CE22F17C6.

Per creare un nuovo progetto accedere a File> New Project Wizzard e apparira un form di introduzione che
si potra evitare venga mostrato nuovamente; ad ogni modo cliccando su “Next” comparira il form in figura 1.2;
a questo punto occorre definire una directory dove mettere il progetto (Quartus II non la crea in automatico),
definire un nome del progetto (es: prova); Quartus II automaticamente dara lo setesso nome anche alla “top-level
design entry”?, ossia I'ultimo campo. Si suggerisce di mettere un altro nome per esempio “main”, in analogia
con il linguaggio C, oppure aggiungere “ top” come suggeriscono i manuali ALTERA. Attenzione perché questo
campo dara il nome al file principale da cui cominciare a scrivere. Proseguire con Next dove sard possibile
inserire dei files al progetto. In questo caso non ce ne sono quindi si prosegue con Next.

Apparira quindi il 3° punto (figura 1.3) che ¢ quello pit importante perché permette di definire il device
target sul quale occorrera scaricare il progetto. Qui si possono fare due cose:

1. Proseguire senza indicare nulla: se si clicca su Next non c’é¢ nessun problema, anzi in alcuni casi é anche
meglio in quanto se si é in fase di sviluppo e non si sa quale FPGA pud contenere il progetto, basta
scegliere la famiglia nel primo menu a tendina e automaticamente Quartus II sceglierd una FPGA ad ogni
compilazione del progetto.

2. Scegliere il dispositivo: se si conosce gia il device di sviluppo é meglio selezionarlo in modo che il compilatore
sappia gia tutte le risorse a disposizione del progetto prima di compilare. Questo crea anche meno problemi
in fase di assegnazione dei pin che deve essere sempre fatta per poter simulare il progetto.

Nel nostro esempio il sistema va settato come in figura 1.3:

!ntellectual Property
2La top-level entry ¢ di fatto il primo modulo che il compilatore implementera per poter costruire il circuito. In altre parole é
“I’inizio del circito”.
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Figura 1.1: Quartus II 13.0 Web Edition 64 bit per Linux

Directory, Name, Top-Level Entity [page 1 of 5]

What is the working directory for this project?

[ Jhome/skynet/Documenti/Programmazione/FPGA/NVERILOG_examples/Provall

What is the name of this project?

[ prova

What is the name of the top-level design entity for this project? This name is case sensitive and must exactly match the entity name

in the design file.
-

[gse Existing Project Settings..

[ < Back H Next > H Finish H Cancel H Help

Figura 1.2: New Project Wizard
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e Family: Cyclone IV E

e Selezionare 'FPGA EP4C22F17C6, aiutandosi eventualmente con il campo “Name filter”

e Avanzare con “Next”

Family & Device Settings [page 3 of 5]

Select the family and device you want to target for compilation.
You can install additional device support with the Install Devices command on the Tools menu.

—Device family ~Show in 'Available devices' list
Eamnily: [Cyclone IV E |v] Package: [Any |v]
Devices: [AII |v] Pin count: [Any |v]

—Target device SHeEs gt [Any |v]

() Auto device selected by the Fitter Hepe i [EP4CE22F ]

Specific device selected in 'Available devices' list [%] Show advanced devices [ | HardCopy compatible only &
) Other: n/a

Ayailable devices:

MName | Core Voltage | LEs | User I/Os | y Bits | Embedded multiplier 9-bit elements | =
EP4CE22F17AT |1.2V 22320 154 608256 132 :
EP4CE22F17CT |1.2V 22320 154 608256 132 &;
EP4CE22F17C8 |1.2V 22320 154 | 608256 132
EP4CE22F17CBL | 1.0V 22320 154 608256 132

EP4CE22F17CHL | 1.0V 22320 |154 608256 1132
4] |

—Companion device =

E

HardCopy: [ |v]

[] Limit DSP & RAM to HardCopy device resources

[ < Back ][ Next = ][ Finish ][ Cancel ][ Help

Figura 1.3: New Projec Wizard - Family&Device settings

A questo punto (passo 4 di 5) viene chiesto di indicare quali altri tool servono per la simulazione ed altre
attivita di sviluppo. Siccome verra trattata solo la simulazione, quindi occorre sceglie il simulatore ModelSim-
Altera, ossia la versione di ModelSim fornita da Altera. Esattamente come Quartus II é scaricabile gratuita-
mente. Siccome nel seguito verra trattato il linguaggio Verilog HDL, occorrera selezionarlo come linguaggio per
la simulazione, come in figura 1.4.

Segue il punto 5/5 che non & altro che un riassunto; cliccando “Finish” il progetto é creato. A questo punto
occorre definire il file principale. Si crea quindi un file cliccando su File> New e comparira il form in figura 1.5
da cui scegliere Verilog HDL.

In figura 1.6 é riportato un file main.v. Pit avanti si entrerd nello specifico dei vari campi. Per ora si noti
che la parte importante ¢ la riga che indica il nome del modulo (module main) che deve essere appunto main.
Quando il file verra salvato, Quartus II proporra automaticamente il nome “main.v”. Questo progetto & gia
compilabile, ma si consiglia di settare nel riquadro Task in basso a sinistra il Flow “Gate Level Simulation” in
modo da ottenere anche il codice per la simulazione.

1.1 Assegnazione dei pin

Il progetto appena creato non fa altro che accendere gli 8 led della scheda DEO-Nano trattandoli come una
variabile ad 8 bit che si incrementa ad ogni colpo di clock.

Occore pero istruire il compilatore per sapere a quali pin questi input e output sono connessi. Alla prima
compilazione infatti, eseguibile con Processing>Start Compilation, Quartus assegnera di default dei pin durante
il processo di “Fit” che si vede nel riquadro “Task” in basso a sinistra.

Vi sono due metodi per assegnare i pin:
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EDA Tool Settings [page 4 of 5]

Specify the other EDA tools used with the Quartus Il software to develop your project.

EDA tools:

Tool Type

Tool Name Format(s) |Run Tool Automatically

Design Entry/Synt..
Simulation
Formal Verification

Board-Level

<None> | <None> v]D Run this tool automatically to synthesize the current desigi

[ModeISim-AItera v||§'uferi|og HDL v]D Run gate-level simulation automatically after compilation

<Nonex> L]
Signal Integrity @
Boundary Scan @

[ < Back ][ Next = ][ Finish ][ Cancel ][

Figura 1.4: New Project Wizard - EDA Tool Settings

- New Quartus |l Project
Bl Design Files
i b AHDL File
Block Diagram/Schematic File
EDIF File
Qsys System File
-~ State Machine File
- SystemVerilog HDL File
i - Tel Script File
| - VHDL File
Memory Files
i - Hexadecimal (Intel-Format) File
H - Memory Initialization File
[El-Werification/Debugging Files
- In-System Sources and Probes File
- Logic Analyzer Interface File
SignalTap Il Logic Analyzer File
University Program VWF

El- Other Files
-~ AHDL Include File
- Block Symbol File
- Chain Description File
- Synopsys Design Constraints File
-~ Text File

0K ][ Cancel ][ Help

Figura 1.5: New File - scegliere Verilog HDL nella sezione Design File
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Figura 1.6: Esempio di progetto in Verilog - il modulo main ¢é la top-level entry

Pin Planer si avvia con AssignmentstPin Planner (figura 1.7) e permette di definire direttamente i pin gia
definiti come input e output nel modulo principale. Appena avviato il Pin Planner, si vede che vi sono gia
dei pin preassociati. Occorre ridefinirli leggendo dove sono associati i vari pin dal datasheet della scheda
DEO-Nano come indicato in figura 1.7. I pin posizionati a mano compaiono come rossi sullo schema del
chip.

Pin Assignment simile al Pin Planner, permette di settare qualsiasi pin con alcune varianti. Per esempio se
non si sa ancora come e dove collegare i vari pin o se i pin di un modulo fossero pit di quelli presenti
sullFPGA, ¢é possibile per esempio definire i pin come virtuali. Ad ogni modo con il Pin Assignment
occorre cercare con le opportune maschere. Il risultato € comunque uguale e si deve avere un risultato
come quello riportato in 2.6.

1l progetto va quindi ricompilato una volta assegnati i pin.

1.2 RTL Viewer

Questo tool permette di visualizzare il circuito descritto dal linguaggio HDL scelto, ottimizzazioni comprese
relative ai circuiti che non concorrono a generare output. Per visualizzare il circuito ocorre effettuare una
compilazione (almeno la prima fase “Analyss & Synthesis”) quindi invocare Tools Netlist Viewer > RTL Viewer.
Eseguendolo sull’esempio in figura 1.6 comparira il circuito in figura 1.9.
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Figura 1.7: Pin Planner
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Figura 1.9: RTL Viewer

2 Esempi base in Verilog

Seguono ora alcuni esempi semplici mirati a capire come funzionano le basi del linguaggio Verilog. Siccome
esistono molti libri e innumerevoli documenti in rete per quanto riguarda sintassi e formalismi avanzati, qui non
verranno trattati nello specifico, mentre si vuole scrivere circuiti che mirino a capire determinate problematiche.
Sintassi e formalismi vari verranno affrontati relativamente al singolo esempio.

Si da per scontata la conoscenza delle porte logiche di base (and, or, not, ecc) e di come esse possono essere
istanziate in Verilog.

Di seguito € riportato un esempio che riporta alcune delle piti comuni istruzioni:

module prova #(parameter n = 8)
( input clk, // clock

input keyoO, // input generico

output [n-1:0] LED, // bus in uscita di 8 bit

output wor out); // complex OR: 1 bit
reg [n-1:0] led = 8’h0; // buffer da 8 bit inizializzato a 0
wire x; // variabile "senza memoria'
assign LED = led; // solo i "wire" possono andare in assignment
assign out = led[1]; // out = ledl or led2 or (led7 xor led0)
assign out = led[2]; // out = ledl or led2 or (led7 xor led0)
assign out = x; // out = ledl or led2 or (led7 xor led0)

always Q@(posedge clk)

begin
if (key0)
led = 8°b1100_0011; // led = 195 (unsigned) - Bloking assignment
else
led <= led + 3°d9; // non-Blocking assignment
end

assign x = led[7] ~ led[0]; // XOR di due bit

endmodule

module descrive il circuito in termini di input-output.

parameter definisce un parametro e ne assegna il valore di default. I parametri servono per configurare le
istanze dei moduli.

input variabile di ingresso. E‘ trattato come un tipo wire.
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output variabile di uscita. E‘ trattato come un tipo wire.
reg variabile di tipo registro che mantiene lo stato (valore) e viene assegnato solo nei blocchi always.

wire variabili che permettono le interconnessioni tra moduli e porte logiche. Vengono assegnati tramite gli
assign statement.

wor wire-or: & di fatto un “filo” in uscita da una porta OR; tutti i valori a cui é assegnata questa variabile
rappresentano gli ingressi della porta OR. Esistono ovviamente anche le variabili wand.

assign statement per ’assegnazione delle variabili wire. sono istruzioni che avvengono “istantaneamente” in-
dipendentemente dal clock, ossia il valore della variabile assegnata dipende dal valore istantaneo di cio
che segue il segno di =.

always blocco che gestisce gli eventi definiti dalla lista di sensitivita che lo segue. Permette di realizzare codice
sequenziale che viene assegnato appunto su evento e quindi le variabili assegnate in questi blocchi devono
essere tipo reg; begin - end sono i due costruttori usati nella logica sequenziale.

@(posedge clk) ¢ un evento scatenante. Cio che segue viene eseguito sul fronte positivo della variabile di
clock. Questa ¢ la lista di senssitivita.

8’b11l 00 11 metodo di definizione dei numeri e delle costanti: x’yzzz_zzz dove z ¢ la base numerica, y &
una lettera che indica la rappresentazione del numero, z sono le cifre del numero; nell’esempio in esame il
numero € costituito da 8 bit pari a 00110011. “_” & solo un separatore per rendere piu chiaro il numero.
Altre basi sono “d” per decimale, “h” per esadecimale; per le variabili tipo bit i valori assegnabili sono 0,
1, x e z, dove x indica “valore indeterminato” e z “alta impedenza”.

= assegnazione per gli statement assign. Se usato nei blocchi always, listruzione & bloccante, ossia I’istruzione
successiva non viene eseguita fino a che questa non é terminata.

<= assegnazione non-blocking nei blocchi always, ossia questo assegnamento viene eseguito in parallelo al-
I’istruzione successiva.

2.1 FLIP-FLOP e LATCH

I flip-flop e i latch sono le strutture principali per la creazione di circuiti, soprattutto se verranno realizzati
contatori o funzioni matematiche di qualche tipo. Seguono quindi alcuni esempi di come realizzare queste
strutture. La comprensione di questo ¢ fondamentale perché permette di capire come scrivere strutture pii
complesse pil avanti.

2.1.1 Flip-Flop con reset sincrono

L’algoritmo 1 rappresenta un flip flop con reset asincrono. Il comando di reset non viene incluso nella lista di
sensitivitd. Questo implica che il segnale di reset verra elaborato solo sul fronte di clock.
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Algoritmo 1 Flip-Flop con reset sincrono

module main

( input clk, // clock
input in, // input
input reset, // reset
output Q); // uscita

reg q = 1°b0;

// Flip-Flop con reset sincromno
A R
always @(posedge clk) // <-- lista di semnsitivita
begin
if (reset)
q <= 1°b0;
else
q <= in;
end

assign Q = q;

endmodule

Compilando il questo codice si vede che il compilatore indica che é stato usato un solo elemento logico (figura
2.1), ossia la variabile q che ¢ appunto un registro. La variabile Q & invece un semplice wire, ossia un filo che
permette di portare in uscita il valore del registro interno al modulo. Anche le variabili di input sono considerate
di tipo wire.

Flow Status Successful - Mon Oct 13 20:53:33 2014

Quartus Il 32-bit Version 13.0.1 Build 232 06/12/2013 SP 1 5] Web Edition
Revision Name main
Top-level Entity Name main

Family Cyclone IV E

Device EP4CE22F17CH
Timing Models Final
Total logic elements 1/22320(<1%)

- Total combinational functions 1/22320(<1%)

Dedicated logic registers 1/22320(<1%)

Total registers 1

Total pins 4/154(3%)

Total virtual pins 0

Total memory bits 0/608,256(0% )

Embedded Multiplier 9-bit elements 0/132(0% )

Total PLLs 0/4(0%)
[ | ]

Figura 2.1: Flip-Flop con reset sincrono - Compilation Report

In figura é riportato invece il circuito ottenuto tramite RTL Viewer dove si vede che di fatto é stata creata
una rete esterna al flip-flop costituita da un multiplexer che sceglie tra il valore '0’ e il valore ’in’ da passare al
flip-flop.

reset q
in 0
ol e
q
kIl

Figura 2.2: Flip-Flop con reset asincrono - RTL Viewer

2.1.2 Flip-Flop con reset asincrono

Nel caso in cui il comando di reset sia interno alla lista di sensitivita (algoritmo 2), il comando di reset diventa
asincrono perché va ad agire sull’uscita senza aspettare la variazione del clock. Il circuito RTL é quello in figura
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2.3. Questo circuito utilizza ancora un elemento logico, mentre la logica combinatoria, ossia il mux usato nel
reset sincrono, é scomparsa.

Algoritmo 2 Flip-Flop con reset sincrono

module main

( input clk, // clock
input in, // input
input reset, // reset
output Q)3 // uscita

reg q = 1°b0;

always @(posedge clk, posedge reset)

begin
if (reset)
q <= 1°b0;
else
q <= in;
end
assign Q = q;
endmodule
Flow summary |
Flow Status Successful - Mon Oct 13 22:32:53 2014
Quartus Il 32-bit Version 13.0.1 Build 232 06/12/2013 SP 1 5] Web Edition
Revision Name main
q Top-level Entity Name main
Farnily Cyclone IV E
Device EP4CE22F17C6
in Q |Timing Madels Final
Total logic elements 1/223200=<1%)
clk Total combinational functions 0/22320(0%)
Dedicated logic registers 1/22320(<1%)
Total registers 1
Total pins 4/154(3%)
Total virtual pins [v]
Total memory bits 0/60B.256 (0% )
reset Embedded Multiplier 9-bit elements  0/132(0%)
Total PLLs 0/4(0%)

Figura 2.3: Flip-Flop con reset sincrono - RTL Viewer

2.1.3 LATCH

I latch mantengono l'uscita al valore dell’ingresso quando, tipicamente, il segnale di ingresso va alto. Negli
algoritmi ¢ mostrato un modo equivalente per ottenere lo stesso risultato. Anche se sembra che il secondo
metodo non usi un registro, in realtd una unitd di memoria verrd impliciramente generata, come si potra

osservare del Compilation Report o dai circuiti RTL in figura 2.4.

10
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Algoritmo 3 LATCH

module main

( input clk, // clock
input in, // input
input reset, // reset
output Q); // uscita

reg q = 1°b0;

always @(posedge clk, posedge reset)
begin

if(reset)
q <= 1°b0;
else
q <= in;
end

assign Q = q;

endmodule

Algoritmo 4 LATCH

module main

( input clk, // clock
input in, // input
input reset , // reset
output Q)3 // uscita

assign Q = clk ? in : Q;

endmodule

PRE
in/»— |0 Q——[@&Q
A S—
| reset (GND) D> CLRN
a

Q$latch

PRE

N0 Q0

clk E———ENA

| reset (GND) D> Boliid
b

Figura 2.4: LETCH generato dagli goritmi 3 (a) e 4 (b)

2.1.4 LATCH con reset

Volendo aggiungere il reset ad un latch in modo simile a come era definito nel flip-flop, si generera semplicemente
una pit o meno complessa logica combinatoria, come riportato in figura 2.5.
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Algoritmo 5 LATCH con reset

module main

( input clk, // clock
input in, // input
input reset, // reset
output Q); // uscita

reg q = 1°b0;

always Q(x*)

begin
if (clk)
q <= in;
else
if (reset)
q <= 1°b0;
end

assign Q = q;

endmodule

q~1
el
resetl—
q
PRE
_ . b Q S
n tNA
4~0 CLRN

Figura 2.5: LATCH con reset - RTL Viewer

2.2 Shift Register

Uno shift register ¢ una catena di celle di memoria da un bit ciascuna che a fronte di un evento di clock spostano
il valore di una cella alla cella successiva.

Per realizzare uno shift-register in Verilog ci sono come sempre molti modi. Tipicamente si utilizzano i
comandi di shift simili a quelli del C come segue:

y = x << 1°b1; // shift logico a sinistra

y = x >> 1°bl; // shift logico a destra

y = x <<< 1°b1; // shift aritmetico a sinistra
y = x >>> 1’bl; // shift aritmetico a sinistra

Oppure sostituendo i vari bit come segue, che é un sistema forse un po’ piu versatile:

{y[n-1:0]1, x}; // shift a destra con sostituzione del primo bit con il wvalore di =z
{x,y[n:11}; // shift a sinistra com sostituzione del’ultimo bit con il wvalore di =z

~

L’esempio riportato nell’algoritmo 6 permette di settare il valore del primo led degli 8 sulla DEO-Nano
premendo il tarso KEY1, mentre premendo il tasto KEYO si ottiene ’avanzamento (shift) dei bit.

12
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Algoritmo 6 Shift Register

module main

( input KeyO, // shift dei bit
input Keyl, // set a 1 del primo bit
output [7:01LED);

reg [7:0] led = 8’h0;
wire keyO, keyl;

always Q(posedge key0 or posedge keyl) // lista di sensitivitd

begin
if (keyl) // con "posedge", 1’if deve essere wero con key=1; viceversa con "mnegedge"
led[0] <= 1°bil;
else
led <= led << 1°bl;
end
assign key0 = “KeyO; // equivalente in gquesto caso a !Keyl
assign keyl = “Keyl;

assign LED = led;

endmodule

Nota: Key0 e Keyl sulla DEO-Nano sono cablate a logica inversa. Per questo, se si vuole usare il fronte positivo per
intercettare gli eventi, occorre negarli come in questo esempio. In pit se nella lista di sensitivita si usa “posedge”,
allora 'argomento dell’if deve essere vero con keyl = 1, mentre con negedge occorrerebbe negare l’espressione
altriemnti si avrebbe un errore di compilazione.

Occorre quindi settare i pin. Si puo utilizzare sia il Pin Planner che 1’ Assignment Editor; quest’ultimo é
forse un po’ piu versatile perché permette di settare anche i pin come virtuali. Prima di avviare il programma,
occorre compilare prima il software e quindi, avviare 1’ Assignment Editor da Assigments> Assignment Editor.
Il programma partird senza campi preimpostati. Occorre inserire manualmente i pin solo nella colonna “To”,
quindi nella colonna “ A ssignment Name” occorre selezionare “ Location (Accept wildcards/groups)’ come in figura
2.6. I vari pin invece vanno indicati a mano esattamente come in figura. Il Pin-out della scheda é disponibile in
rete. Terasic e ALTERA forniscono anche il file .gsf con gia 'assegnazione per tutti i pin.

| & main.v [] | sgk Compilation Report - main [] | \& Assignment Editor  [£] I
<<new>> || Filter on node names: ’* |v]§Category.[A|| |']
i aty Fram To Assignment Name Walue | Enabled Entity Comment
< 1 | 75— Key0 PIN_J15 Yes
v - < [ PIN_E1 ves |
3 |« out | ED[1] Location PIN_A13 Yes 1
4 | out | ED[2] Location PIN_B13 Yes 1
5 |« =4t |ED[3] Location PIN_A11 Yes 1
6 |+ 4t |ED[4] Location PIN_D1 Yes 1
7 |« 24t LED[5] Location PIN_F3 Yes ]
8]V o Leofs) —
s v % Leop) —
10|« _9% LED[O] Location (Accepts wildcards/groups)
11 o MEW e NEW Implement as Output of Logic Cell
p— i Infer RAMs from Raw Logic (Accepts wildcards/groups)
Input Delay from Dual-Purpose Clock Pin to Fan-Out Destinations (Accepts wildcards/groups)
Input Delay from Pin to Input Register (Accepts wildcards/groups)
Input Delay from Pin to Internal Cells (Accepts wildcards/groups)
Input Transition Time (Accepts wildcards/groups)
[‘_l Iteration limit for constant Verilog loops (Accepts wildcards/groups)
Iteration limit for non-constant Verilog loops (Accepts wildcards/groups)
Keep synchronous clear/preset behavior for DDIO INPUT when unmap I/Q wysiwyg primitives

Location [Accepts wildcards/groups)

Figura 2.6: Assignment Editor
A questo punto occorre ricompilare e scaricare sulla scheda il software che andra a scriversi in ram. Per

farlo occorre lanciare il programmatore con Tools> Programmer e, se non ha caricato il file, occorre aggiungerlo
manualmente. Il file é nella directory output_files/ ed é il file main.sof.
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Nota implementativa: una volta programmata la scheda, basta agire sulle Key0 e Keyl per testare il fun-
zionamento. Se i LED avanzano velocemente é a causa dei rimbalzi multipli dei pulsanti che andrebbero
filtrati in qualche modo, per esempio con un filtro temporale che restituisca il valore dopo un certo tempo.

Nota Tri-state pin: é bene sempre definire che tutti i pin non assegnati diventino input in alta impedenza.
Per farlo occorre invocare Assigments> Device> Device and Pin Option e scegliere “ As input tri-state” come
in figura 2.7. Se i led non fossero tutti assegnati e non si facesse questo procedimento, si vedrebbero i led
legermente accesi perché sarebbe setato un pull-up. Questo procedimento si puo fare gia all’inizio in fase
di creazione del progetto.

Categaory:
Configuration
Programming Files Specify device-wide options for reserving all unused pins on the device. To reserve
individual dual-purpose configuration pins, go to the Dual-Purpose Pins tab. To reserve
Dual-Purpose Pins other pins individually, use the Assignment Editor.
Capacitive Loading
Board Trace Model L
110 Timing Reserve all unused pins ‘;As input tri-stated |v]
Voltage
Pin Placement
Error Detection CRC
CwP Settings
Partial Reconfiguration
Description:
Reserves all unused pins on the target device in one of 5 states: as inputs that are tri-
stated, as outputs that drive ground, as outputs that drive an unspecified signal, as input
tri-stated with bus-hold, or as input tri-stated with weak pull-up
[ oK l [ Cancel ] [ Help ]

Figura 2.7: Device and Pin Options - Unused Pin

2.2.1 Istruzioni Parallele e Sequenziali - Blocking & non-Blocking statements

I circuiti programmabili hanno tutti la peculiarita che pressoché tutto il codice & parallelo. Per verificare il
parallelismo delle istruzioni si considerino i due algoritmi seguenti. Entrambi accendono un led e lo spostano
fino all’ultima posizione a intervalli di circa 1s.

Scaricando sulla DEO-Nano ’algoritmo numero 7, si vedra che il primo led (led0) si accendera e scorrera fino
alla posizione 8 (led7 acceso). A questo punto tutti i led si spengono per poi accendere nuovamente il led0 dopo
circa un secondo e ricominciare il processo. Questo & dovuto al fatto che nel blocco always gli assegnamenti
sono non bloccanti. Sinoti che se ’assegnazione led <= led << 1’bl venisse posta dopo I'if, il risultato sarebbe
identico.
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2.2 Shift Register

Algoritmo 7 Shift register - non blocking

module main ( input wire clk,

output wire [7:0] Q);

parameter n = 24;

reg [7:0] led;
reg [n:0] count;

initial
begin
led <= 0;
count <= 0;
end

always @Q(posedge clk)
begin

count <= count + 1°’bl;
end

always @(posedge count|[n])

begin
led <= led << 1’bl; // non—blocking
if (led = 0)
led <= 1’bl; // questa istruzione non pud essere blocking
end

assign Q = led;

endmodule

Nota: se la prima assegnazione & non-blocking (ossia <=) la seconda all’interno dell’if non puo essere blocking.

Scaricando ’algoritmo 8 invece si ha che i led non si spegneranno mai tutti. Questo perché nell’istante in
cui si ha 'ultimo shift, la variabile led diventa zero e successivamente viene eseguito 1’if che ripristina il primo

bit a 1.

Algoritmo 8 Shift register - blocking

module main ( input wire clk,

output wire [7:0] Q);

parameter n = 24;

reg [7:0] led;
reg [n:0] count;

initial
begin
led <= 0;
count <= 0;
end

always @(posedge clk)
begin

count <= count + 1’bl;
end

always @Q(posedge count[n])
begin

led = led = 1’bl; // blocking

if(led — 0)

led = 1°bl; // questa istruzione pud essere blocking

end
assign Q = led;

endmodule
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2.3 Contatori e Moltiplicatori

Contatori e moltiplicatori si realizzano con delle normali operazioni. In particolare i contatori vengono realizzati
sfruttando gli elementi logici del’FPGA, mentre i moltiplicatori, quando possibile, vengono implementati usando
i moltiplicatori hardware gia presenti in alcune FPGA come la Cyclone IV in esame.

L’algoritmo 9 riporta una mac normalizzata. Si noti che nel compilation report (figura 2.8) viene indicato
I'utilizzo di 8 embedded multiplayer. Per sfruttare le risorse del’FPGA e non i moltiplicatori embedded, si puo
usare il moltiplicatore dato con le Megafunction di ALTERA (Tools>MegaWizard Plugin Manager e scegliere
LPM_ MULT).

Algoritmo 9 MAC normalizzata

module mac( input clk,
input [31:0] A, B, C,
output [31:0] Q);

reg [63:0] q;
always Q@Q(posedge clk)
begin
4 <= A« B+ {C,{32{1°b0}}};
end

assign Q = q[63:32];

endmodule

Successful - Wed Oct 15 23:03:03 2014
13.0.1 Build 232 06/12/2013 SP 1 5] Web Edition

Flow Status
Quartus |l 32-bit Version

Revision Name

Top-level Entity Name

Farmily

Device

Timing Models

Total logic elements
Total combinational functions
Dedicated logic registers

Total registers

Tatal pins

main

main

Cyclone IV E
EP4CE22F17C6

Final
112/22320(<1%)
112/22320(<1% )
327223200l «1%)
32

129 /154 (84 % )

Total virtual pins 0

Total memory bits 0/608,256(0%)
Embedded Multiplier 9-bit elements 8/132(6%)
Total PLLs 0/4(0%)

Figura 2.8: MAC - Compilation Report

3 Simulazione

La simulazione é il primo strumento di debug che permette di valutare sia se il codice scritto funziona dal punto
di vista logico che funzionale. In particolare si hanno due tipi di simulazione:

RTL Register-transfer level simulation: verifica il funzionamento del circuito a livello logico e quindi ideale.
Permette di simulare ogni singolo modulo qualunque sia il linguaggio con cui € stato scritto, senza dover
simulare tutto il progetto.

Gate-Level o anche Functional simulation: é la simulazione funzionale, ossia una simulazione realistica del
circuito scritto tenendo conto dei ritardi dovuti all’hardware. Questo tipo di simulazione & pitt complesso,
soprattutto per simulare singole parti di circuito; inoltre ¢ molto importante definire il linguaggio con cui
¢ descritto il circuito. Se il programma ¢ scritto sfruttando molti linguaggi, occorre convertire tutto il
progetto nel linguaggio scelto per la simulazione.
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L’algoritmo 10 ha come scopo la simulazione del circuito per valutare innanzitutto le differenze tra i due tipi di
simulazione. L’obiettivo € portare in uscita su due pin un clock e il valore di un registro il cui valore é condizionato
proprio dal clock. 11 clock in ingresso é da 50MHz e viene poi ridotto a 10MHz tramite un PLL inserito con
una MegaFunction. Per inserire il PLL occorre invocare il Megafunction Wizard con Tools> MegaWizard Plug-
In Manager. Comparira quindi un form a cui occorre indicare di creare una nuova megafunction cliccando
su “Create a new custom megafuncion variation”. Cliccando su “Next” comparira il form da cui scegliere la
MegaFunction e occorre settare i vari campi come in figura3.1:

oec
Which megafunction would you like to customize? which device family will you be using? [Cyclone e "]
Select a. megafunction from the list below
i ?
[Js PLL “_zl Which type of output file do you want te create

) AHDL
YHOL
@ Verilog HOL

|=; ﬂ Installed Plug-Ins
B 170

‘4, ALTPLL_RECONFIG
[ Interfaces

What name do you want for the putput file?

[nazmnefFPGNVER\LOG_examp\es,fSECOM;‘DEUNano_R\tarleemporahuljpll B

- (3 Transceiver PHY
% Arria V GZ Transceiver PLL vl Output files will be generated using the classic file structure
., Arria V Transceiver PLL v13.0 "] Return to this page for another create operation
x .Cyrlane ¥ Transcever I VT Note: To compile a project successfully in the Quartus Il software, your design
*4, Stratix ¥ Transceiver PLL 13| files must be in the project directory, in a library specified in the Libraries page
B 33 PLL of the Options dialog box (Tools menu), or a library specified in the Libraries
g page of the Settings dialog box (Assignments menul.
“\, Altera PLL Reconfig v13.0

Your current user library directories are:
, Altera PLLv13.0 b4
1 click to Open IP MegaStore

1 [RAREDY

[ Cancel ][ < Back l[ Next > ][ Finish

Figura 3.1: Megafunction: variation declaration

definire un nome della variante, in questo caso pll

e scegliere il linguaggio in cui la variante verra definita, nel nostro caso Verilog HDL

indicare nel filtro PLL in modo da trovare subito la funzione desiderata

scegliere ALTPLL, ossia TALTERA Phase-Locked-Loop megafunction

Cliccando su Next comparira il configuratore della megafunction (figura 3.2). Nella prima pagina occorrera
indicare che il clock di ingresso ¢ 50 MHz e che lo speed grade® della FPGA ¢ 6*. Avanzando nelle schede,
eliminare tutte le selezioni fino ad ottenere un solo segnale di ingresso (inc1k0) e uno di uscita (c0).

3Lo speed grade & uno dei parametri piti importanti che definisce principalmente la velocita del componente e definisce i limiti
massimi del PLL

4Speed Grade = 6 si deduce dal nome del’FPGA: EP4ACE22F17C6N. Questo valore indica che la massima frequenza ammissibile
in uscita dal PLL ¢é di 315MHz.

17



3.1 RTL Simulation 3 SIMULAZIONE

'Zj ALTPLL =

[T]Parameter

Currently selected device family: [cyclone v E -

[%] Match project/default

neko [ —— el Able to implement the requested PLL
Operation Mode: Normal

~General

Which device speed grade will you be using? 6 -
Cyclane IV E

[] Use military temperature range devices only
What is the frequency of the inclk0 input? 50,000
[ Set up PLL in LVDS mode Data rate: [ Not Available [+| Mbps

~PLL Wp
Which PLL type will you be using?
() FastPLL () Enhanced PLL @ Select the PLL type automatically

~Operation Mode
How will the PLL outputs be generated?
@ Use the feedback path inside the PLL

® In normal mode
) In source-synchronous compensation Mode
) In zero delay buffer mode

[_] Connect the fbmimic port (bidirectional)
() with no compensation

() Create an 'fbin' input for an external feedback (External Feedback Mode)

Which autput clock will be compensated for?

‘ Cancel | ‘ <ga:k| | Next > ‘ ‘ Finish |

Figura 3.2: Megafunction configuration

Algoritmo 10 Esempio per la simulazione

module main

( input clk , // 50 MHz
output clkMirror,
output Q);

wire clk10; // 10 MHz
reg q = 1°b0;
reg [7:0] count = 8°h0;

pll pll inst
( .inclk0 ( clk ),
.c0 ( clk10 ));

assign clkMirror = clk10;
assign Q = q;

always @(posedge clk10)
begin
count <= count + 1’bl;
q <= count [7];
end

endmodule

Si noti che per effettuare le simulazioni sarebbe meglio settare anche i pin, 0 quantomeno eseguire la prima
fase di compilazione (sintesi).

3.1 RTL Simulation

Per prima cosa, questo tipo di simulazione non necessita tipicamente di nessuna configurazione particolare.
Cliccando due volte su uno dei moduli ¢ possibile simularli anche singolarmente. Se la simulazione non fun-
zionasse, occorre in Quartus II ricreare i simboli del file che contiene il modulo. Non é questo il caso, ma a titolo
informativo occorre cliccare file (main.v) con il tasto destro e cliccare su “ Create Symbol Files for Current File”.
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A questo punto si puo rilanciare la simulazione cliccando su Tools> Run Simulation Tool > RTL Simulation e verra
avviato il ModelSim (figura 3.3), ma tutto cido non bastera: infatti se si clicca due volte sul modulo main per
simularlo, ModelSim non funzionera a causa del fatto che il programma contiene le Megafunction ALTERA.

=g
File Edit Wiew Compile Simulate Add Library Tgols Layout Bookmarks Window Help
B-aH2E) i ol oA E| e
Layout [Siaulate hd H ColumnLayout [ALLEa Luras - H
2 = H Secw w o M | Gearch: | pREE B ‘

$a Objects —ii— +| @ x| | gg| Wave - Detault

|7/ Name

[SEait et
© 0wl || %
BT

a-ga-a|lpl
L NI

H A %

¥ Nams 2]

= i work L

] main

W el

1] pll_altpll
#4l} gate_work
-4l il work
= fi 220mode!
+-4l, 220model_ver
+4l, attsra
Hfll atera_insim
#4l attera_Insim_ver
#4l attera_mi
= i atera_mi_ver
#4l, attera_ver
= attgeb
= i atgsb_lib
4l altgeb_ver
#ofll amiage
=l ariage_hssi
#4l arriage_hssi_ver
#4l armiage_ver
£ I <
i Libray - [BTProge BEE! S P || S — B | |

A Transert = CEF

b ocesses (Active) i H 2

rlName "

rrrrFCFrCfFFrF-CFCfFFCFCCECC ===

4

4 Regioa: fmaia/pll_iast Al
¢ Searched Libravies:

+ Fhome/skyast/Documeat [/ Programuacioas/EPGR/VERILOG examy Les/SECOM/DE (Naae_RitacdiTemporalill/s mulat ioa/models (o/ ekl work

4 Ecror loadiag desiga

i |
|ModsISim:= 7

<No Design Loadsd> <No Corntexts I

Figura 3.3: Model Sim - RTL Simulation

Perché si possano simulare questi progetti, occorre parametrizzare la simulazione come segue:

e avviare la simulazione dal menu di ModelSim: Simulater> Start Simulation

selezionare dal form appena avviato (figura 3.4-a) Work > main

e selezionare quindi le librerie manualmente cliccando sull’etichetta Libraries (figura 3.4-b). Aggiungere le
seguenti librerie relative al linguaggio Verilog®: altera_ ver, altera_mf wver (per le megafunction), lpm_ ver
e soprattutto la cycloneive_ ver.

¢ Quindi eseguire la simulazione cliccando su “OK”

A questo punto si pud procedere con la simulazione. Nei riquadri centrali (Objects) compariranno tutte le
variabili simulabili. trascinarle nel form Wave-Default e configurare il clock di ingresso cliccando col tasto destro
su /main/clk (in Wave-Default), scegliere “Clock” e settare nel campo “Period” del form che comparira, 20ns
e quindi “OK”. A questo punto settare come tempo di simulazione un tempo adeguato, per esempio 100us ed
eseguire la simulazione cliccando sul tasto a fianco. Apparira ’oscillogramma come in figura 3.5. Cliccando sulle

forme d’onda, con i comandi “c”, “0” e “1” si potra zoommare fino a vedere che tutti i fronti sono perfettamente
allineati al clock a 50MHz senza alcun ritardo. Quando 1’8 bit del contatore é alto, anche 1'uscita Q ¢ alta.

3.2 Gate-Level Simulation

Per eseguire la simulazione funzionale occorre compilare il progetto eseguendo 1”’EDA Netlist Writer” che, se &
selezionato nel riquadro “ Tasks” la compilazione “ Gate Level Simulation”, tutto avverrd in automatico.
A causa del fatto che il progetto & stato scritto in Verilog e che é stato indicato a ModelSim che il linguaggio

di simulazione & appunto il Verilog HDL, occorre sempre definire le librerie per la simulazione come fatto in

5In realta non servono tutte queste librerie per questa simulazione, ma per altre piti complesse si
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Designl VHDL] \."erilag} Libraries } SDF ] Cthers ] 4|3 Design] VHDL} Verilog  Libraries | SDF } Cthers ] 43
¥ Name |Type |Path 5 rSearch Libraries {-L)
;,-m work Library rl_waork ':aLtera_ve T Add. |
] main Module  thome/skynetDocumentiProgramm :TLEE“—"’E—VE £
i el Medule fhame/sky net'Documenti/P rogramm ";ci:ﬂ:::we_\,e = Modify...
1] pll_altpll Module ‘homeiskynet'Documenti/Programm | e
4l gate_werk Library thomeiskynetDocumenti/Programm QE =
ﬂ-ﬂl Hi_work Library ‘homeiskynetDocumenti/Programm
g-M 220model Library FMODEL_TECH! falterafvhdli220m
i+ J!l 220meodel_ver Library FMODEL_TECH! faltzrafverilog/22 v e bl Bt s Firsti-lt)
| < | [ i Add
Design Unit(s) Resolution
’Vfwor.k..ma.j:.n ] ‘ ’Vd.eEault ﬂ‘ fecin
Delets
Optimization
’V [~ Enahble optimization Optimization Options
OK Cancel OK Cancel
a) b)
Figura 3.4: Start Simulation
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Figura 3.5: Esecuzione della simulazione RTL

20
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precedenza al paragrafo 3.1. Avviare quindi ModelSim da Quartus II tramite Tools> Run Simulation Tool > Gate
Level Simulation e quindi procedere come segue:

e avviare la simulazione dal menu di ModelSim: Simulate>Start Simulation
e selezionare dal form appena avviato (figura 3.4-a) Work>main

e selezionare quindi le librerie manualmente cliccando sull’etichetta Libraries (figura 3.4-b). Aggiungere le
seguenti librerie relative al linguaggio Verilog: altera_wver, altera_mf ver (per le megafunction), lpm_ ver
e soprattutto la cycloneive ver.

¢ Quindi eseguire la simulazione cliccando su “OK”

A differenza del caso RTL si vede che nel riquadro “Objects” compaiono moltissime altre variabili. E‘ quindi
bene inserire solo le variabili che servono: sicuramente gli input e output (distinguibili da una freccia verde sui
rombi) ed eventuali variabili interne tra cui il clock a 10MHz identificato dalla variabile “sim: /main/\pll_inst|-
altpll_component |auto_generated|wire_plll_clk[0]~clkctrl_outclk”, ossia l'uscita del PLL. Anche in questo
caso si aggiunge il clock a 50MHz settando il periodo a 20ns e quindi si simulano 100us. Il risultato ¢ quello in
figura 3.6.

In questa simulazione si vede che i vari fronti non sono tutti sincronizzati, ma ci sono dei ritardi variabili in
funzione dei vari segnali. Tra il clock riportato sul pin in uscita a l'uscita Q, ci sono quasi 0.815ps.
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Figura 3.6: Esecuzione della simulazione Gate-Level

Nota: per automatizzare le simulazioni future € possibile salvare lo stato attuale cliccando prima nel riquadro
Wave, e quindi dal menu File>Save Format salvare il file wave.do (si pud anche cambiare nome). Questo
file non ¢é altro che uno script e quindi editandolo aggiungendo come prima linea “vsim -L altera_ver -L
altera_mf_ver -L lpm_ver -L cycloneive_ver -do main_run_msim_gate_verilog.do -1 msim_transcript -i
work.main”, ogni volta che si aprird questo file partird questa simulazione, ma senza settaggi e forzamenti
delle variabili. Aggiungendo alla fine del file gli appositi comandi, sard possibile anche configurare le
variabili. Tutti i comandi che si danno graficamente verranno riportati nella console “ Transcript” in basso
nel ModelSim; basta copiarli nel file .do.
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3.3 Verifica dei ritardi in hardware

I pin scelti e settati tramite Assignent Editor (figura 3.7) sono i seguenti:

clk PIN RS, clock da 50MHz
clkMirror PIN J14, mirror del clock a 10MHz: pin 40 del connettore GPIO01 (GPIO 133 sugli schemi della
scheda)
q PIN 113, 8° pin del contatore: pin 36 del connettore GPIO01 (GPIO 129 sugli schemi della scheda)
[ & main.v ] \*; Assignment Editor B l
<<new=>  [¥ Filter on node names: [* |v]
i -atu From To | Assignment Mame | Value Enabled Entity Comment I Tag |
= 1| il Location PIN_R8 Yes
2 |« I ot clkMirror | Location PIN_|14 Yes ]
3|« I - c Location PIN_L13 Yes ]
4 CCNEWDD CCNEWDD CCNEWDD

Figura 3.7: Assegnamento Pin per verifica comportamento hardware

In questo esempio ¢ stato introdotto un PLL per portare da 50 a 10MHz il clock in quanto la lettura
di 50MHz su é abbastanza disturbata. Non é chiaro se sia dovuto al pin o alla banda passante della sonda
dell’oscilloscopio. A questo punto collegare al pin 12 del connettore GPIO01 la massa dell’oscilloscopio e le
sonde sul pin 40 e sul 36. In figura 3.8-a verifica che la frequenza del clock di uscita siano 10MHz, mentre in
figura 3.8-b si ¢ cercato di verificare il ritardo di simulazione (figura 3.6) che ¢ stato misurato come un po’ meno
di 1 pico secondo; ¢ difficile misurare tempi di questa entitd, ad ogni modo la figura 3.8-b misura un’ordine di
grandezza simile e 'intervallo & misurato ad occhio € stato preso forse un po’ piii largo. Ad ogni modo ’obiettivo
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T T T T T T v T T T

] . . ]
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Figura 3.8: Verifica frequenza a 10MHz (a) e misure dei ritardi dell’algoritmo 10 (b)

é dimostrare il ritardo hardware che é sempre da considerare quando si sviluppa un circuito. Tale ritardo non &
sempre costante: infatti il ritardo appena misurato é estremamente contenuto, ma questo dipende dalle logiche
implementate, dal tipo di FPGA, ecc. Di norma ¢ bene considerare che le operazioni abbiano un ritardo pari o
prossimo al valore dello speed grade del’FPGA (6 ns in questo caso).

4 Altri esempi

A fronte del fatto che i tempi vano opportunamente verificati in funzione delle operazioni che si fanno, occorre
tenere presente che ogni operazione ha pesi differenti. Seguono quindi degli esempi che mostrano in simulazione
i ritardi di alcune operazioni. Questi tempi sono attendibili.

4.1 Moltiplicazione con una pipe

La moltiplicazione che segue viene eseguita sul fronte di clock in modo da poter verificare quanto trascorre dal
fronte di clock alla stabilizzazione dei valori:
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module main #(parameter n = 16) // metodo migliore di definizione dei parametri per simulazionti RTL
( input clk, // 50 HHz
input [n-1:0]4A, B, // 4 e B sono wariabili a 16 bit

output [n-1:01Q);
reg [(n*2)-1:0] q; // valore a 32 bit: risultato della moltiplicazione

always @(posedge clk)

begin
q <= A * B;
end
assign Q = q[(n*2)-1:n]; // Moltiplicazione normalizzata: uso solo i 32bit altd
endmodule

Compilando e avviando la simulazione Gate-Level, eseguire la simulazione ricordandosi di aggiungere le
librerie come spiegato a pagina 21. Aggiungere quindi tutti gli input, gli output e la variabile Q. Settare quindi
i valori dei vari input a piacere. Essendo una simulazione il clock pud essere fissato a meno di 50MHz, per
esempio a 100ns®; A e B possono essere settate a piacere, per esempio 2000 e 4000 rispettivamente. Siccome
“tutto € un bit” anche i numeri sono definiti in bit. Per evitare di dover inserire tutti i bit e convertire i numeri,
é possibile definire la base numerica per esempio con 1042000 che indica base 10 e valore 2000 come mostrato
in figura 4.1. La visualizzazione dei valori é poi conveniente metterla in decimale.

Clock Mame
5 iotfmaLase Lk

— offset

[a

— Period

E.]l.I]EIn.E

Legic Valuess
ﬁigh:gi-  Low:|a
FirstEdge———
’75 Rising  Falling

Signal Name:;la Lonr/maiofd

Value:[10#2000

Kind
’7 “* Freere [ Drive ¢ Deposit

Delay For: EI

Cancel After: :“

Cancel

Ok Cancel |

b)

Figura 4.1: Set clock (a) e dei valori di A e B (b)

Eseguendo quindi una simulazione e andando a cambiare dopo 400us il valore di A, si vede al successivo
fronte di clock quando il valore si ¢ stabilizzato (figura 4.2-a). La prima cosa che si nota ¢ che inizialmente Q ha

[TP%IR

un valore pari a “z”; questo perché non é stato assegnato nessun valore iniziale. q invece ha gli ultimi valori a
“2”; questo percheé quei valori tendenzialmente non servono alla moltiplicazione perché comunque vengono presi
soltanto i bit piu significativi e quindi vengono posti in “alta impedenza” (z appunto).

Proseguendo si vede che in 4.2-b il ritardo dal fronte di clock positivo e il risultato stabile della moltiplicazione
sono 3.53ns. Non a caso si é detto “risultato stabile”™ se infatti si ingrandisce 'intorno del cambio di valore
del risultato si osserva che il valore in realta é cambiato due volte andando, la prima volta, anche a un valore
piu elevato del risultato finale. Questo spiega perché é sempre bene clockare sia 'ingresso di una funzione, sia
clockarne 'uscita in modo da renderla disponibile solo dopo un adeguato tempo oltre il quale si € sicuri che il
valore sia stabile onde evitare problemi transitori. Quest’ultimo passo in questo esempio non viene mostrato,
ma esiste sul sito ALTERA un ottimo esempio.

6Si noti che ridurre la frequenza dei segnali, soprattutto quelli di clock, pud accelerare in alcuni casi le simulazioni.
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/main/B

= fmaintl

Mo

Cursor 1

Now
Cursor 1

Cursor 2

c)

Figura 4.2: MUL - (a) Simulazione, (b) misura ritardo del calcolo, (c) variazione intermedia del calcolo
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Nota: La moltiplicazione normalizzata qui implementata é realizzata con variabili intere unsigned a 16 bit.
Una completa moltiplicazione normalizzata che tenesse conto del segno dei due valori a 16 bit, dovrebbe
essere diversa perché il bit di segno dei due numeri moltiplicati andrebbe a finire in un unico bit di
segno. In questo caso, quindi, la vera moltiplicazione sarebbe tra due numeri positivi a 15bit seguita da
un’opportuna gestione del segno.

4.2 PWM

La Pulse Width Modulation é una tecnica che permette di controllare un’uscita digitale in modo che la tensione
media di questa uscita in un dato intervallo di tempo (detto periodo di commutazione) risulti pari al valore di
tensione per il duty-cycle d:

dove T,, ¢ il il tempo in cui l'uscita permane allo stato alto (1 logico, 3.3V fisico), mentre T ¢é il tempo
totale (T, + Torr); per quanto detto quindi, se la tensione in uscita su un pin allo stato logico “1” della FPGA
é a V=3.3V, allora la tensione media in un periodo di switching sara:

]Ln
T

Questa tecnica viene usta per il controllo di inverter, chopper, ecc. Infatti se l'uscita dell’FPGA va a
comandare l’accensione e lo spegnimento di un componente di potenza (es: IGBT), é possibile modulare una
tensione di uscita che, mediamente, abbia una forma d’onda desiderata (per esempio una sinusoide). Applicazioni
tipiche sono il controllo di motori sincroni, asincroni, sincroni a magneti permanenti, generatori statici, ecc.

La PWM é una funzione che é quasi sempre fornita da opportune periferiche dei DSP o microprocessori
industriali per inverter relativamente semplici. Realizzare questa funzione su FPGA tipicamente ha il vantag-
gio di poter realizzare molti canali PWM, poter avere una elevata risoluzione in tensione, avere una elevata
diagnostica, poter controllare varie topologie anche molto complesse, ecc.

v=V-.6=V"

4.2.1 Pulsazione di un LED

Per ottenere una PWM occorre comparare un segnale portante (carrier) con un segnale modulante che rappre-
senta ad ogni tempo ciclo il duty-cycle. L’esempio che segue genererd una carrier a 14 bit e la confrontera con
un duty-cycle a 12. Per semplicita il duty-cycle é aggiornato a fronte dell’azzeramento della carrer; siccome la
carrier € un contatore che incrementa un bit alla volta, il suo valore tornera 0 quanto ’ultimo suo bit andra a 0.

module SimplePWM

( input clk, // 50MHz - PIN_RS
output LED); // LEDO - PIN_A415

parameter c¢ = 14;

parameter d = 12;

reg [d:0] duty_cycle = 1°d0;
reg [c:0] carrier = 1°d0; // portante: dente di sega

// Creazione della portante
always @(posedge clk)
begin

carrier <= carrier + 1’bl;
end

// Creazione del duty-cycle
always @(negedge carrier[c])
begin
duty_cycle <= duty_cycle + 1’bil;
end

assign LED = duty_cycle > carrier[c:c-d];

endmodule
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L’esecuzione di questo codice porta ad illuminare gradualmente il LEDO. Per come é concepito il programma
si ha che:

e la frequenza di periodo di switching dipenda dalla carrier e dal clock e sara pari a: T = %;6 = 655.36us

e siccome la triangolare si azzera ogni T, la frequenza di switching é semplicemente fgy = % = 1525.88H z

e il led tende ad illuminarsi partendo dalla condizione di spendo, raggiunge il massimo dell’illuminazione e
si spegne nuovamente in modo istantaneo.

Per evitare che il led si spenga in modo istantaneo si pud o agire sulla carrier o sul duty-cycle: uno dei due,
raggiunto il suo massimo, deve ridursi gradualmente. E‘ chiaro che chi deve ridurre il suo valore deve essere la
carrier percheé il duty-cycle nella pratica ¢ dato da una sorgente esterna (tipicamente un regolatore).

L’esempio appena visto serve solo per capire il principio di funzionamento della PWM. Nel paragrafo suc-
cessivo si realizzerd un esempio un po’ piul realistico che si scontra con i problemi tipici della progettazione di
una PWM, come:

e cosa occorre fare per realizzare una frequenza di switching desiderata? (es: 1kHz)
e ¢ meglio mantenere stabile il numero di bit e variare i clock o viceversa?

e ¢ quindi conveniente lavorare in potenze di 2 0 no?

4.2.2 PWM

L’esempio che segue pud sembrare complesso, ma in realtd cio che conta fare delle scelte per risolvere delle
specifiche di progetto, che potrebbero essere queste:

e Ottenere una frequenza di 2kHz

e La frequenza potrebbe essere settata in modo differente a valori diversi dal precedente (600Hz, 1kHz,
4kHz, ecc)

e La risoluzione in tensione deve essere almeno di 1/1000 alle varie frequenze

Dall’esempio visto al paragrafo 4.2.1 sembra che lavorare in potenza di 2 sia la cosa piu pratica. Questo &
effettivamente vero, ma € chiaro che non si puo creare una qualsivoglia frequenza con una potenza di 2 a meno
da non ritoccare il clock; il clock della DEO-Nano infatti ¢ un 50MHz e quindi ottenere un clock da un PLL che
sia esattamente una potenza di 2 potrebbe non essere cosi semplice. Una modifica hardware per mettere un
clock da 32768kHz non é ovviamente praticabile.

Quindi ipotizzando che la soluzione a “potenza di 2”7 sia la migliore, allora ’alternativa é variare lo step che
non potra pit essere di un solo bit, ma dovra essere normalizzato e quindi “spalmato su piu bit” per tenera alta
la precisione e ridurre conseguentemente I’errore di integrazione. Questo vuol dire che occorre fare alcune scelte
arbitrarie. A titolo di esempio si considerino le seguenti:

e lo step di incremento della carrier viene definito su una base di 16 bit.

e in un certo senso lo step rappresenta i decimali. La carrier allora dovra essere di altri 16 bit per un totale
di 32 bit.

e per semplicita anche il duty-cycle dovra essere un valore a 32 bit.

e la carrier deve essere signed. Questo forse complicherd un po’ le cose dal punto di vista implementativo,
ma dal punto di vista logico dovrebbe essere un po’ piu chiaro.

e chiaramente anche il duty-cycle sard un valore signed.

e la carrier sara una triangolare pura, quindi quando raggiungera il valore massimo, ricomincera a scendere
fino a raggiungere il valore minimo.
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Nota: se la portante (carrier) é una triangolare, allora la frequenza di switching (fsw ) & il tempo che intercorre
tra due vertici. Nei sistemi di controllo, se possibile, & bene che il douty-cycle vari ad ogni vertice della
triangolare, ossia due volte in un intervallo di switching. D’ora in avanti quindi si intende il tempo di
campionamento (o di sample) come la meta del tempo di switching T, = %% e chiaramente la frequenza
di sample sara fs = 2fgw .

Da queste prime specifiche si capisce che la carrier ¢ un numero che deve essere compreso tra —23! =231, Quindi
quando il duty-cycle & pari a 0 il valore reale in uscita sara del 50%.

Definizione dello step fissato il clock a 50MHz, la carrier deve raggiunge il valore 23! dopo 500us e tornare
a 0 dei successivi 500 ps per avere una frequenza di 1kHz. Quindi lo step dovra essere di:

231
« 171799
500-10-6.50- 106

ovviamente questo ¢ un valore approssimato che non porta ad avere perfettamente 1kHz, ma l’errore ¢
comunque molto contenuto e quindi trascurabile.

Definizione del modulo PWM 1l modulo PWM non é particolarmente importante. Viene riportato solo
per completezza. Di fato & un semplice PWM che permette, grazie al segnale syncEnable, di effettuare una sola
commutazione tra due vertici della triangolare rispettando cosi la frequenza di switching richiesta anche a fronte
di una variazione del duty-cycle piu rapida.

module PWM

( input clk, // clock
input syncEnable, // 4bilitazione per la commutazione
input signed [31:0] mod, // modulante o duty-cycle da applicare
input signed [31:0] carrier, // portante
output P // comando P secco

)3

reg CommEnable = 0; // Commutation Allowed

reg C = 1°b0; // comandi della PHHN

reg Cm = 1°b0; // mirror comando PWH

always @(posedge syncEnable or posedge clk)

begin
if (syncEnable)
begin
Cm = C; // memorizzo lo stato della PWN
CommEnable = 1°bil; // riabilito la commutazione
end
else
if(Cm ~ C)
CommEnable = 1°b0; // disabilito la commutazione
end

// Generazione della commutazione pura senza tempo morto
always @(posedge clk)
begin
if (CommEnable)
C = ($signed(mod) > $signed(carrier));
end

assign P = C;

endmodule

Costruzione della carrier (triangolare) se la carrier non fosse pensata per essere realizzata come potenza
di 2, sarebbe relativamente complicato gestirla perché occorrerebbe tenere conto della pendenza positiva e
negativa per sommare o sottrarre lo step scelto. Inoltre occorrerebbe gestire ’overflow oltre il valore massimo
e minimo della triangolare.

La carrier pensata in potenza di 2 invece & comoda perché la si puo costruire con semplici operazioni logiche
e anche i vari bit hanno un significato. In particolare si ha che:
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il bit 31 del contatore che generera la carrier (cnt) rappresentera anche la pendenza della carrier stessa

X0R (~) del contatore con il suo bit piu significativo permette di invertire il suo andamento creando la
triangolare. Tale triangolare é perd un numero che varia tra 0 e 23" — 1.

Per centrare il valore occorre quindi sottrarre la meta, ossia 230 — 1.

Per poi tornare a lavorare a 32 bit occorre poi shiftare a sinistra in modo aritmetico di 1 bit. Tutto questo
porta all’istruzione seguente: carrier = (((cnt ~ {32{cnt[311}}) - {30{1’°b1}}) <<< 1°d1);

Definizione del duty-cycle per 8 LED Giusto per complicare un po’ ’esempio, il codice seguente riporta
anche come far variare su tutti gli 8 LED la PWM. Di fatto viene fatta una inizializzazione di 8 contatori
precaricati con 1/8 di periodo ciascuno.

Le cose pit importanti da notare sono:

1. sync: questo segnale non é altro che un impulso che viene generato ad ogni vertice della portante. Tipi-
camente questo € un segnale di sincronismo che viene o generato dalla FPGA oppure dal DSP e serve per
tenere sincronizzati questi due dispositivi. In questo caso viene generato solo dalla FPGA e passato al
modulo pwm.

2. 1l ciclo for utilizzato genera effettivamente del codice. Infatti é impossibile modificare I'indice del ciclo,
ma si puod solo utilizzarlo.

3. Sono state invocate 8 istanze del modulo pwm a mano. Se fossero state molte di piu sarebbe stato un
problema.

module main(
input clk, // clock da 25Nz, quindi a 50MHz viaggerd a 2kHz la fS¥
output [7:0] LED); // comando poritivo

reg signed [31:0] dutyTmp [7:0];
reg signed [31:0] duty [7:0];

reg [31:0] cnt = 0} // contatore di base da cut generare la carrier

reg slope = 1°bl;

reg signed [31:0] carrier; // Va gestito per forza come Teg e non come wire

wire sync; // Equivalente di un cmando di sync da un uC/DSP. Ora lo genero io.

integer ij;

initial
begin
for (i=0; i<8; i = i+1)
begin
dutyTmp[i] <= 32°d536870912 * ij;
duty[i] <= 0;
end
end

always @(posedge clk)

begin : Counter
// lo metto qui con 1’"=" per essere certo di passare un ciclo.
slope = cnt[31];

// step: 171799 = 1kHz @ clk=25¥; cambiando questo si cambia la frequenza di switching
cnt = cnt + 32°d171799;

// NOT4: si perde comunque il bit meno significativo!
carrier = (((cnt =~ {32{cnt[311}}) - {30{1°b1}}) <<< 1°d1l);
end

assign sync = slope ~ cnt[31];
// Generazione del DutyCyle
always Q@(posedge clk)

begin
for (i=0; i<8; i = i+1)
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begin
dutyTmp [1] <= dutyTmp[i] + 32°db4;
duty[i] = (((dutyTmp[i] ~ {32{dutyTmp[iJ[31]3}3}) - {30{1°bl}}) <<< 1°d1);
end
end

PWM pwmil

( .clk(clk),
.syncEnable(sync),
.mod($signed (duty[0]1)),
.carrier($signed(carrier)),
.P(LED[0]));

PWM pwm2

( .clk(clk),
.syncEnable(sync),
.mod($signed (duty[1])),
.carrier($signed(carrier)),
.P(LED[1]));

PWM pwm3

( .clk(clk),
.syncEnable(sync),
.mod ($signed (duty[2])),
.carrier($signed(carrier)),
.P(LED[2]));

PWM pwm4

( .clk(clk),
.syncEnable(sync),
.mod ($signed (duty [3])),
.carrier($signed(carrier)),
.P(LED[3]));

PWM pwmb

( .clk(clk),
.syncEnable(sync),
.mod ($signed (duty[4])),
.carrier($signed(carrier)),
.P(LED[41));

PWM pwm6

( .clk(clk),
.syncEnable(sync),
.mod($signed (duty[5]1)),
.carrier($signed(carrier)),
.P(LED[51));

PWM pwm7

( .clk(clk),
.syncEnable(sync),
.mod($signed(duty[6]1)),
.carrier($signed(carrier)),
.P(LED[61));

PWM pwm8

( .clk(clk),
.syncEnable(sync),
.mod($signed (duty[7]1)),
.carrier($signed(carrier)),
.P(LED[71));

endmodule

Generate statement Come detto al paragrafo precedente, realizzare 8 istanze del modulo PWM a mano.
Nell’esempio sono riportati dei cicli for che operano direttamente sulle variabili come indici. E¢ possibile fare la
stessa cosa con i blocchi generate che permettono di istanziare moduli, assign statement, always statement, ecc
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in modo statico. In altre parole il codice viene “esploso” e le varie istanze sono i nomi indicate dopo il begin;
per questa ragione nei blocchi generate il nome dell’istanza dopo il begin € obbligatorio.

Altra cosa fondamentale ¢ che le variabili utilizzate dai blocchi generate devono essere variabili di tipo
genvar; queste variabili vengono cancellate dopo la generazione del codice e non possono essere utilizzate al di
fuori di generate.

Il codice che segue ¢ esattamente quello riportato a pagina 25, ma estremamente pit compatto.

module main(
input clk,
output [7:0] LED
)

reg signed [31:0] dutyTmp [7:0];
reg signed [31:0] duty [7:0];
reg [31:0] c¢nt = 0;

reg slope = 1’bl;

reg signed [31:0] carrier;

wire sync;

integer ij;

initial
begin
for (i=0; i<8; i = i+1)
begin
dutyTmp[i] <= 32°d536870912 * ij;
duty[i] <= 0;
end
end

always @(posedge clk)
begin : Counter

slope = cnt[31];

cnt = cnt + 327d171799;

carrier = (((ecnt =~ {32{cnt[31]}}) - {30{1°b1}}) <<< 1°d1);
end

assign sync = slope ~ cnt[31];

// Generazione del DutyCyle
always @(posedge clk)

begin
for (i=0; i<8; i = i+1)
begin
dutyTmp[i] <= dutyTmp[i] + 32°d54;
duty[i]l = (((dutyTmp[i] =~ {32{dutyTmp[il[3113}3}) - {30{1°b1}}) <<< 1°d1);
end
end

// Generazione di tutte le 8 PWH
genvar j;
generate
for (j = 0; j < 8; j =3j + 1) begin : pwumInstance
PWM pwmX
( .clk(clk),
.syncEnable(sync),
.mod($signed(duty[j1)),
.carrier($signed(carrier)),
.P(LED[j1));
end endgenerate

endmodule

Compilando il modulo in questo modo verranno quindi generate 8 istanza di PWM chiamate pwmInstance][i]
come si vede dalla figura 4.3 che riporta la gerarchia dei moduli chiamati.
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Project Navigator Bax

Entity Logic Cells| Dedicated Logic Registers |
(i :Cyclone IV E: EP4CE22F17C6

S pod main & 847 (575) | 368 (352)
gﬁ PWM: pwminstance[0]. pwmX | 34 (34) 212)
gﬂ PWM:pwminstance[1l]. pwmX 34 (34) 21(2)
g PWM:pwminstance[2]. pwmX | 34 (34) 202
gﬁ PWM:pwminstance[3]. pwmX 34 (34) 212)
gﬁ PWM: pwminstance[4] pwmX | 34 (34) 21(2)
gﬁ PWM:pwminstance[5]. pwmX | 34 (34) 2(2)
gﬁ PWM:pwminstance[6]. pwmX 34 (34]) 212)
pbd PWM:pwminstance[7].pwmX | 34 (34) 21(2)

< BI]
/% Hierarchy |E] Files ‘ # Design Units | %, IP Companents | | ,l)

Figura 4.3: Istanze del modulo PWM

4.3 Memoria Interna

L’FPGA come detto puo avere all’interno alcune unitd precablate grazie alle quali ¢ possibile avere alcune
funzionalitd senza dover ricorrere all’utilizzo di risorse logiche del dispositivo. Esattamente come per i moltipli-
catori visti in precedenza (4.1) anche per la memoria & possibile utilizzare o le risorse logiche o risorse interne.
Dai compilation report visti fino ad ora (figure 2.1, 2.8), si pud notare che questa FPGA possiede 608256 bit di
memoria utilizzabile come RAM o ROM.

Tipicamente questa memoria viene usata per fare da cache nei processori come il NIOS II [7], ma puo essere
indirizzata anche come semplice memoria interna, per fare una dual-port RAM, ecc. La frequenza di accesso a
questa memoria € pari alla frequenza massima consentita dal PLL, ossia 315MHz; cid implica che lo speed grade
del dispositivo impatta anche sulle performance di questa unita. Per maggiori informazioni consultare [9].

Specifica L’esempio che segue prevede di realizzare una PWM che realizzi una una forma d’onda sinusoidale.
La sinusoide sard mappata in memoria, ma non completamente. Per risparmiare infatti, il seno verra mappato
solo per un quarto, sufficiente per realizzarlo per qualsiasi valore dell’angolo. I passi da eseguire sono i seguenti:

e Creare un PLL (Megafunction) per ottenere due frequenze: 25MHz e 12.5 MHz: questo perché questo
esempio era stato sviluppato su una Cylone III C8 e per non avere problemi si é preferito mantenerlo
identico come timing. Inoltre frequenze pit basse hanno alcuni vantaggi sulla risoluzione di alcuni calcoli.
Per inserire la Megafunction seguire i passi descritti al capitolo 3 e abilitare sia ’uscita c0 che 'uscita c1.

e Creare la Megafunction per la RAM. Siccome verra solo letta si puo scegliere anche la ROM e precaricarla
con un file .mif il quale non ¢é altro che una tabella che pud essere scritta in calec, Matlab o con cosa si
preferisce e si possono copiare i dati con un semplice copia-incolla.

e Realizzare quindi una PWM come fatto negli esempi recedenti

o Aggiungere il DeadTime per avere una PWM piu realistica: un inverter reale infatti deve avere un certo
“tempo morto” tra 'accensione di un IGBT e laltro per permettere ai diodi di clamp di ripristinare la
barriera di potenziale. In questo esempio, in quanto ideale, si potrebbe anche evitare.

e Creare un angolo per accedere alla RAM. Per le scelte fatte ’angolo ¢ un numero a 32 bit unsigned.
Analogamente per quanto fatto per creare la triangolare, anche qui si ricorre al’XOR, ma non sull’ultimo
bit, bensi sul penultimo. Questo creera una triangolare di frequenza doppia rispetto alla variazione
dell’angolo come in figura. Questo perché il valore ottenuto ci permettera di avere un valore dell’angolo
variabile tra 0-90° dove é stato definito il seno. Il valore del seno dovra poi tenere conto del segno in
funzione del vero valore dell’angolo a 32 bit.

Implementazione Creazione del file MIF:

e Selezionare un nuovo file: Filer New e selezionare Memory Initialization File
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Figura 4.4: Andamento di Theta e Angle

Vo

e Alla richiesta di quante word: inserire 24, ossia 16384; questo ¢ il valore del bus indirizzi che é un bus a

14 bit

e Impostare word size a 15 perché si vuole un valore del seno a 16bit con segno, quindi il seno varia tra 0 e
215 — 1 nella semi-onda positiva, mentre in quella negativa andra gestito il segno e quindi si avra un bit
in piu; é ’equivalente del bus dati.

e Caricare il file creando con un foglio elettronico o un qualunque altro programma, un seno variabile tra
. Copiare il risultato nel file .mif e salvarlo. Dovrebbe apparire qualche cosa

0 e 90° moltiplicato per

come in figura 4.5.

215

& main v 1 | @  compiationReport-main [ | & SinCos. mif a |

addr [ +0 [ +1 [ +2 | 43 [ +4 | +5 [ +6 [ +7 [ +8 | +9 | +10]| +11 | +12 [ +13 | +24 [ 425 [ +16 | +17 | +18 | +19 | +20 | +21 [ +22 [ +23 | Ascll [+

0 3 6 8 13 |16 |18 |2 |25 28 3 3B 3 4 |4 |47 |50 53 5 60 63 66 69 72 #8),250<
24 |75 7a 82 |85 88 |81 84 (97 101 104 107 (110 113 116 |18 123 (126 |120 132 135 138 141 145 148 | KORUX“mehknah
48 |11 154 [157 160 163 (166 (170 173 (176 |179 (182 185 188 (192 (185 (198 (201 (204 207 210 24 |7 (220 223

72 226 (229 232 (236 (239 242 245 248 251 254 258 261 264 267 270 273 276 280 283 (286 (289 (292 295 (298

96 302 305 308 311 314 N7 320 324 327 330 333 336 339 342 346 349 352 355 358 361 384 388 371 374

120 |377 (380 383 38 390 (383 (395 (309 402 405 (408 412 415 418 (420 (424 427 430 434 437 440 443 M6 M9

144 |452 456 450 462 465 (488 471 (474 477 481 48B4 487 490 493 496 (439 (503 (506 509 512 515 518 521 525

168 |S28 531 534 SI S40 |43 (547 S50 559 556 (559 62 565 (69 572 (575 (578 (SB1 584 S8V (591 (S84 597 600

192 |603 606 609 613 616 (619 (622 (625 628 631 (635 638 641 644 647 (650 (653 (657 660 663 666 669 672 675

216 (679 682 685 688 691 694 697 701 704 707 |70 713 716 |T19 722 726 729 732 735 738 T4 744 Ta8  TS1

240 (754 757 (7e0 763 766 770 773 776 779 782 (785 788 (792 |795 798 801 804 807 810 814 817 820 823 826

264 |820 832 836 839 842 (845 (848 BS1 854 G5B 861 854 867 870 E73 876 880 883 885 883 892 95 898 801

288 |305 %08 $11 914 $17 (920 (923 (827 90 933 (936 938 %42 945 M9 (952 (955 (956 961 964 967 9T 974 977

312 (980 983 986 999 993 (996 (999 1002 1005 1008 1011 1015 1018 1021 1024 (1027 1030 1033 1037 1040 1043 1046 1049 1052

336 (1055 1059 1062 1065 1068 1071 1074 1077 1080 1084 1087 1090 1093 1096 (1099 1102 1106 1109 1112 1115 1118 1121 1124 1128

360 (1131 1134 1137 1140 1143 1146 1150 1153 1156 1158 1162 1165 1168 1172 1175 1178 1181 1184 1187 1190 1194 1197 1200 1203

384 [1206 1200 1212 1215 1218 1222 (1225 1228 1231 1234 1237 1241 1244 1247 1250 (1253 1256 1250 1263 1266 1269 1272 1275 1278

408 |1281 1285 1288 1281 1204 1297 1300 (1303 1307 1310 1313 1316 1319 1322 1325 1328 1332 1335 1338 1341 1344 1347 1350 1354 %
< ] L)

Aggiungere la Megafunction:

Figura 4.5: File

MIF

e Ayviare il Magafunction Wizard: Tools>MegaWizard Plugin Manager.

e Selezionare ROM-1 port (aiutarsi con i filti scrivendo ROM).

32



ALTRI ESEMPI 4.3 Memoria Interna

o Configurare la rom come in figura 4.6.

e Aggiungere il file .mif (figura 4.7) che deve essere stato creato in precedenza e formattato adeguatamente.

e Procedere e completare la configurazione.

'Z) ROM: 1-PORT

Currently selected dewvice family: Cyclone IV E -

[%] Match project/default

How wide should the 'q' output bus be? bits
How many 15-bit words of memory? 16384 n words

Mote: You could enter arbitrary values for width and depth
Blekiype- ALY ~What should the memory block type be?

@ Auto ) MLAB ) MIK

Set the maximum block depth to words

~What clocking method would you like to use?

® Single clock
) Dual clock: use separate ‘input’ and ‘output’ clocks

| Cancel | ‘ <gack| | Next > ‘ | Finish |

Figura 4.6: ROM 1-Port - Address & Data configuration

") ROM: 1-PORT

~Do you want to specify the initial content of the memory?

() Ng, leave it blank

m Initialize memory content data to XX.. X on
power-up in simulation

@ ‘es, use this file for the memory content data

{You can use a Hexadecimal (Intel-format] Fle [.hex] er a Memery Initialization Fle [.mif])

Browse. ..

File name: | SinCos. mif ]
The initial content file should conform to which port's dimensions? ﬂ

Block type: AUTO

0 Allow In-Systern Memory Content Editor to capture and
update content independently of the system clock

The 'Instance ID' of this ROM is:

| Cancel | ‘ <gack| | Next >4 | Fnish |

Figura 4.7: ROM 1-Port - Preconfigurazione con file .mif

1l codice prevede quindi la creazione di un bus a 14 bit, ossia angle. Questo angolo é derivato da theta il
quale ¢ il vero angolo che variera tra 0 e 2w. Ovviamente la rappresentazione in virgola fissa implica che, scelta

la base a 32 bit, I'angolo vari tra 0 e 232 — 1.
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Nota: gli angoli sono le grandezze tipiche da mantenere a valori interi a potenze di 2; questo perché an-
goli e numeri interi sono entrambe funzioni cicliche e quindi non occorre gestirne 'overflow come invece
occorrerebbe fare con rappresentazioni floating point.

La creazione della variabile angle &, come detto, realizzata basandosi sul penultimo bit di theta prendendo solo
14 bit. Questo porta alla seguente istruzione: angle = theta[29:16] ~ {14{theta[30]}}

Il codice € quindi il seguente:

module main

( input clkl, // clock 50MHz
output [7:0] LED, // led
output P, // PWM +: PIN_P11 (GPIO_110) pin 10 GPIOI
output N); // PWM -: PIN_T11 (GPIO_17) pin 15 GPIOI
// Definizione det clock
wire clk?2; // clock a 25HHz 50/2
wire clké4; // clock o 12.5MHz 50/
wire sync; // segnale di sync per evitare le commutazioni multiple

wire signed [14:0] sin; // seno a 15 bit in uscite dalla RAN

wire [13:0] angle; // angolo ridottto a 0-pi/2 (é un’altra triangolare di fatto)
reg signed [15:0] duty; // Duty-Cycle

reg [31:0] theta = 0; // angolo effettivo 0-2pi da cui otterremo "angle"

wire p; // PWH positiva senza dead time

reg slope;
reg [31:0] carrier; // triangolare per realizzare la PWHN
reg [31:0] cnt; // contatore da cui ottenere la carrier

// Creazione dei due clock aggiuntivi
pll pllo
( .inclk0 ( clkl ),

.c0 ( clk2 ),

.cl ( clk4 ));

// Generazione dell’angolo: piw il clock é lento, maggiore é la risoluzione numerica
// dello step, ma minore é la risoluzione dell ’angolo.
always @(posedge clk2)
begin : AngleGeneration
theta <= theta + 30°d8590; //step 8590 per avere 50Hz con un clock di 26MHz
end

// L’angolo é normalizzato a 14 bit ed é una triangolare
assign angle = theta[29:16] ~ {14{theta[30]}};

// Creazione del seno ridotto: é di fatto 1/4 di seno.
// Si entra con Angle e si esce con 1/4 di seno sempre positivo.
rom rom0
( .address ( angle ),
.clock ( clk2 ),
.q ( sin ) );

// Generazione del Duty-Cycle a 16bit con segno

A R E R
always @(negedge clk4) // il clock deve essere piu lento di quello che genera theta
begin
if (theta[31])
duty <= -{1°b0, sin[14:0]%};
else
duty <= +{1°b0, sin[14:0]%};
end

// Generazione della Carrier con clock a 50MHz per ottenere 2kHz di switching

e
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always @(posedge clkl)

begin : Counter
slope = cnt[31]; // con "=" si é certi di passare un ciclo.
cnt = cnt + 32°d171799; // step: 171799 = 2kHz @ clk=50H;
//ent = cnt + 32°d858993; // step: 858993 = 10kHz @ clk=50HM;
carrier = (((cnt =~ {32{cnt[31]1}}) - {30{1°b1}}) <<< 1°d1l);
end
assign sync = slope ~ cnt[31];

// Generazione di una gamba PWN

A e
PWM pwmO
( .clk(clkl),
.syncEnable(sync),
.mod ({duty, {16{1°b0}}}), // modulante a 32 bit signed
.carrier(carrier),
P(p) D3

// Adpplicazione del tempo morto: inm questo esempio non servirebbe,
// ma cosi si realizza un caso pid realistico.
DeadTime
( .clk(clkl),
.dt(10°d250), // 250050MHz = 5us di deley, 50 = 1lus
.p(p), .n(!p),
.P(P), .N(N) );

// Adssegnazione dei led
assign LED = {{6{1°b0}}, P, N};

endmodule

Test in Hardware Per effettuare il test di questo programma occorre configurare i pin P e N come indicato
nel software e in figura 4.8. Questo perché cosi sara possibile collegare un filtro RC e verificare che effettivamente
si sta creando una sinusoide a 50Hz come richiestp.

11 filtro RC va connesso tra il pin 10 del connettore GPIO1 e la massa; il condensatore va a massa ovviamente.
11 filtro utilizzato prevede una resistenza da 1k€2 e una capacita di 4.7uF che porta ad avere una banda passante
di 212Hz circa. La funzione di trasferimento nel dominio della frequenza é:

1
s-R-C+1

Questa funzione tornera utile in seguito per verificare il comportamento del filtro e avere delle controprove
relativamente alle frequenze di uscita.

Il primo test & una verifica visiva: in figura 4.9 si vede I’andamento del duty-cycle preso sui due pin di uscita
P e N che varia con una frequenza che gia si intuisce circa 50Hz. Si nota subito perd che vi sono dei “buchi” nelle
due PWM quando uno dei pin rimane acceso quasi totalmente: in questo momento l’altro pin rimane spento
per un certo tempo. Cio é dovuto al tempo morto che, essendo pari a 5us fa si che di fatto non vi é abbastanza
tempo per accendere il pin (figura 4.9-b).

Il secondo test prevede invece di verificare la sinusoide: per farlo si preleva il segnale in uscita sul pin P e la
tensione sul condensatore. Si noti che P'FPGA esce con una tensione che varia tra 0 e 3.3V; questo implica che
se la tensione viene filtrata, il suo valore medio sara pari a 1.65V. Quindi per avere una migliore risoluzione, il
canale 1 & stato triggerato in AC in modo da avere un valore medio nullo. In figura 4.10 ¢é riportata la forma
d’onda filtrata. La frequenza letta ¢ mediamente di 50Hz e la forma d’onda sembra leggermente attenuata e
sfasata rispetto alla PWM. Questo é corretto percheé se si calcola I'attenuazione dalla funzione di trasferimento
si ha:

G(s) =

1
G(2750) = = 0,561
V(2750 R-C)2 +1

che quindi genera una tensione picco-picco di:

Upp = G(2750) - V = 1.85
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Tek stop

Figura 4.8: Connessione dell’oscilloscopio
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Figura 4.9: Verifica PWM a 50 Hz - a) canale CH1:P e CH2:N - b) zoom sulla cresta della sinusoide
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il che é analogo a quanto misurato in 4.10-a.

Tek Prevu e E— Maisz Filter Off Tek Pievu S S S— S— Naise Filter Off
T T T T T T T T T T

Eoooob e D] O —dnims @ 920my i
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Figura 4.10: Verifica PWM a 50 Hz - a) canale CH1:Vc e CH2:P - b) zoom in un punto di commutazione

5 Virtual JTAG, TCL & Qt

11 capitolo che segue é fortemente orientato alle FPGA ALTERA in quanto verra utilizzata una IP distribuita
solo con il sofware Quartus II, ossia Virtual JTAG” [4]. La comunicazione con questo dispositivo avviene
direttamente con I’'USBBIlaster, ma occorre necessariamente:

e un server TCL che permetta, tramite opportune chiamate, di dialogare con il vJTAG: il server é basato
sull’esempio descritto in [6]

e un client che si colleghi al server TCL: per ragioni di semplicita e portabilita & stato scelto di scriverlo in
Qt, ma si pud scegliere qualunque altro linguaggio

Ovviamente chi é esperto di TCL puo editare lo script che esegue il server per inviare i comandi senza sfruttare
il socket TCP vero e proprio.

JTAG e Virtual JTAG 11 JTAG® ¢ un dispositivo che, tramite un opportuno protocollo, permette di
prendere il controllo di un dispositivo integrato attraverso alcuni pin dedicati. Di fatto questo € un dispositivo
seriale che permette di mettere in catena anche pit dispositivi comunizzando alcuni segnali come il clock e
serializzando alcuni comandi di input e output. Tramite il JTAG é possibile programmare un dispositivo o
semplicemente interrogarlo per esempio per attivita di debug.

11 JTAG é gia presente sulla scheda DEQ-Nano ed ¢ 'USBBlaster e serve come noto per la programmazione.
Pero, una volta creato il nostro circuito, il canale JTAG non viene piu utilizzato a meno che in si aggiungano
uno o pitt JTAG virtuali sfruttando I'IP fornita da ALTERA.

Uno degli esempi tipici del vJTAG é per il debug e programmazione dei microprocessori NIOS II. In figura
[6]-Figureb ¢ riportato lo schema funzionale del circuito. Non si vuole ora entrare nel merito di tutti i pin e
delle varie funzioni del JTAG; cio che basta sapere € il significato dei seguenti segnali:

TCK ¢ il clock generato. Da alcuni test (non riportati in questo documento) il clock misurato aveva una
frequenza di 4MHz.

TDI Transfer Data IN: é un segnale che viene serializzato in funzione del clock TCK. Di fatto sono i dati
che possono provenire dal sistema di debug; nel nostro caso saranno i dati inviati dal client QT al
server TCL e da quest’ultimo al’FPGA. La lunghezza in bit di questi dati pud essere qualsivoglia,
ma si vedra che di fatto saranno multipli di 4 bit.

TDO Transfer Data OUT: é un segnale che viene serializzato in funzione del clock TCK. Di fatto sono i
dati che 'FPGA invia verso sistema di debug. Questi dati potranno essere eventualmente scartati
dal sistema. La lunghezza di questi dati é pari a quella del TDI (in bit).

IR in Input Instruction Register: questo registro appare al’FPGA come un bus che puo essere al massimo
di 26 bit. Viene inviato dal programma di debug.

"Le altre case hanno normalmente la loro versione di questo tipo di dispositivo
8Standard IEEE 1149.1
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IR out Output Instruction Register: equivalente dell’IR in, ma in uscita fal'FPGA verso il server. Puo
essere ignorato dal programma.

DR Sono i dati che verranno poi serializzati sulla linea TDI.

5.1 Inserimento del Virtual JTAG

L’esempio che si vuole realizzare prevede di:
e accendere i led tramite il registro IR da 8 bit
e far tornare all’interfaccia un valore a 8 bit che incrementa in funzione dalla pressione del tasto KEY0
e verificare il valore dei dati ricevuti premendo KEY1 (8 bit)

Una volta creato il progetto come indicato al capitolo 1, avviare il Megafunction Wizard (come al paragrafo
2.3) e scrivere “jtag” nella parte relativa al filtro dei nomi; scegliere quindi “Virtual JTAG” e indicare un nome
per le istanze, per esempio vjtag come indicato in figura 5.1.

Which megafunction would you like to customize? which device family will you be using? | Cyclone IV E
Select a megafunction from the list below

[, itag
= Ed_] Installed Plug-ins

=[] JTAG-accessible Extensions
\ In-System Sources and Probes

‘\ Parallel Flash Loader What name do you want for the output file?

\ Serial Flash Loader - - - -
X 'Documentu’Programma2|oneJ’FPGANERILOG_exampIeSNlr‘tuaIJTAG02MtagI

X ] Which type of output file do you want to create?

@ Verilog HDL

SignalTap Il Logic Analyzer
Qutput files will be generated using the classic file structure

7 click to Open IP MegaStore ["] Return to this page for another create operation

Note: To compile a project successfully in the Quartus Il software, your design
files must be in the project directory, in a library specified in the Libraries page
of the Options dialog box iTools menul, or a library specified in the Libraries
page of the Settings dialog box (Assignments menu).

Your current user library directories are:

[ Cancel ] [ < Back ] [ Next = ] [ Finish

Figura 5.1: Virtual JTAG: crazione della Megafunction

La configurazione di base a titolo di esempio prevede un IR pari a 8 bit e settare a Manual = 0 l'istanza
(figura 5.2). Le pagine seguenti permettono di realizzare degli stimoli in automatico. Lasciare tutto inalterato.
Proseguendo si nota che il wizard indica che la libreria da usare ¢ altera_ mf (ossia ALTERA MegaFunction).
Questa libreria andra inclusa in simulazione e dovra essere altera_mf wver in quanto il software é scritto in
Verilog.

A questo punto occorre inserire il JTAG all’interno dell’esempio. Si noti che tipicamente occorre creare un
interprete comandi per gestire i comandi IR e un data-shifter che trasferisca, per esempio in un registro, i dati
dal TDI ed un altro data-shifter che trasferisca i dati in uscita sul TD0. Tutto sincronizzato con il clock del JTAG
TCK.

Un altro registro molto importante ¢ il vsdr, ossia il virtual state shift data register: quando questo segnale
é alto, il vJTAG sta trasferendo i dati.

Il codice del modulo principale é il seguente:

module main(
input clk,
input keyO,
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5.1 Inserimento del Virtual JTAG

'Z) Virtual ITAG

tdo

ir_out{7..0] ir_in[7..0] =
virtual_state_cdr
wvirtual_state_sdr
virtual_state_e1dr
virtual_state_pdr 4
virtual_state_e2dr
wvirtual_state_udr
virtual_state_cir -
virtual_state_uir -

R R R )

How wide should the instruction register be?
How will you assign a unigue instance index?

() Automatic

Currently selected device family [ cyclone v E n

[®] Match project/default

D Create primitive JTAG state signal ports

| Cancel | | <gack| ‘ Next > ‘ | Fnish |

Figura 5.2: Virtual JTAG - Config Step 1
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Figura 5.3: Virtual JTAG - Pin assignment
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input keyl,
output [SIZE-1:0]1led);

parameter SIZE = 8;

wire TDo, TDij; // Transfer data In/0Out

wire [SIZE-1:0] IRi, IRo; // Instruction register In/0ut

wire tck; // clock wvirtuale del JTAG

wire vsdr; // Virtual State Data register

wire [SIZE-1:0] Dataln; // registro 0 e registro 1 che verranno moltiplicats

reg [SIZE-1:0] DataOut = 8°d0; // registro dati in uscita

// Istanza del JTAG
vijtag vJTAG(

.ir_out (IRo), // IR in uscita, non considerare qut
.tdo(TDo), // Transfer data in uscita

.ir_in(IRi), // IR in entrata inviato da PC
.tdi(TD1i), // Transfer data in ingresso

.tck(tck), // clock del JT4G
.virtual_state_sdr(vsdr)); // Stato del trasferimento dat:

// Istanza dello shifter per caricare ¢ dati in ingresso (NON % comandi)
DataShifterIN #(SIZE)

DS_in

( .clk(tck),
.vsdr(vsdr),
.tdi(TDi),

.q(DatalIn));

// Istaenza dello shifter per ¢ dati in uscita
DataShifterQUT #(SIZE)
DS_out
( .clk(tck),
.vsdr(vsdr),
.data(Datalut),
.tdo (TDo));

always @(posedge keyO)

begin
Datalut <= DataOut + 1°b1l;
end
assign led = keyl ? IRi : Dataln; // Le KEY somno in logica negata: premuta é 0
endmodule

Il codice piu importante é pero quello relativo agli shifter dei dati in ingresso e uscita. In particolare
DataShifterIN prende in ingresso il segnale TDI in modo da andare a caricare in un registro i dati che arrivano
in modo seriale sincronizzati con il clock del JTAG. DataShifter0UT invece ha in ingresso un valore a 8 bit e,
tramite uno shift register, preleva i vari bit e li invia ad ogni colpo di clock verso 1'uscita, ossia al JTAG. 11
codice é il seguente:

/*x DataShifterIN ******xx*
K ok ok ok ok K K ok ok ok ok K ok ok ok ok ok ok ok ok ok ok Rk /
module DataShifterIN
( input clk,
input vsdr,
input tdi,
output [SIZE-1:0] q);

parameter SIZE = 8;
reg [SIZE-1:0] outcome = 16°d0;

always @(posedge clk)
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begin
if (vsdr)
outcome <= {outcome[SIZE-2:0], tdi};
end

assign q = outcome;
endmodule

/*% DataShifterQUT ***xk**
Kok kKRR KRR KR KK KK K K K Kk
module DataShifterOUT
( input clk,
input vsdr,
input [SIZE-1:0] data,
output tdo);

parameter SIZE = §;
reg [SIZE:0] count; // servirebbe il log2

always Q@(posedge clk)

begin
if (vsdr)
count <= count + 1°d1;
else
count <= 8°d40;
end
assign tdo = datal[countl];
endmodule

5.1.1 Comunicare con il Virtual JTAG

Ora rimane solo la parte di comunicazione. La soluzione proposta riprende ’esempio descritto in [6] e si basa
poi sulla documentazione di riferimento del vJTAG [4] che é ovviamente completa e quindi un po’ dispersiva
(in quanto vasta).

Di fatto ALTERA mette a disposizione un interprete comandi TCL quartus_stp che, oltre ai comandi
standard TCL, aggiunge alcuni comandi per la comunicazione con il Virtual JTAG. I due comandi principali
che interessano sono i seguenti:

device_virtual_ir_shift € il comando che trasferisce il valore dell’instruction register dal PC verso 'FPGA. I
comandi che vuole sono i seguenti:

-instance_index ¢ il valore dell’istanza; normalmente € 0 in quanto quando € stata aggiunta la Megafunc-
tion e stata definita manualmente l’istanza settandola a 0.

-ir_value € il valore dell'Instruction Register da inviare. Il valore deve essere espresso rigorosamente in
decimale.

-no_captured_ir_value indica che il programma non restituird un IR proveniente da FPGA; in altre
parole il comando non ¢ interruttivo. Questa opzione pud essere omessa e in quel caso il comando &
interruttivo e restituira un IR.

device_virtual_dr_shift ¢ il comando per trasferire il registro dati DR che verra letto tramite il segnale TDI
nel software.

-dr_value é il valore del registro DR da inviare. Pud essere un valore decimale o esadecimale; in
quest’ultimo caso non deve avere “0x” davanti.

-length é la lunghezza dei dati. In linea teorica puo essere qualsivoglia compatibilmente con i dati inviati.
Di fatto é bene che sia un valore multiplo di 4. Questo valore indica i bit di dati da trasferire.
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-value_in_hex indica che il valore dei dati che segue -dr_value & espresso in esadecimale. Se omesso i dati
verranno intesi in base decimale.

-instance_index ¢é l'istanza del vJTAG, tipicamente 0.

-no_captured_ir_value se omesso (e nei nostri esempi é omesso) attende il trasferimento dati dalla FPGA.

Di seguito é riportato il codice del server TCL senza troppi commenti per ragioni di spazio. Quello che ¢é
importante € capirne il funzionamento, ossia I'apertura di un socket in ascolto su una porta dedicata scelta a
piacere in attesa di due comandi IR e DR provenienti da un programma esterno (nel nostro caso scritto in Qt).
Il programma ¢ il seguente:

#This portion of the script is derived from some of the examples from Altera

global usbblaster name
global test device
# List all available programming hardwares, and select the USBBlaster.
# (Note: this example assumes only one USBBlaster connected.)
# Programming Hardwares:
foreach hardware name [get hardware names]| {

if { [string match "USB-—Blasterx" $hardware name] } {

set usbblaster name $hardware name
}

}

puts "\nSelect .JTAG_chain_connected_to_$usbblaster name.\n";

# List all devices on the chain, and select the first device on the chain.
foreach device name [get device names —hardware name $usbblaster name]| {
if { [string match "Ql+" $device name] } {
set test device $device name
}

puts "\nSelect_device:_$test device.\n";

# Open dewvice
proc openport {} {
global usbblaster name
global test device
open device —hardware name $usbblaster name —device name $test device

# Close device. Just used if communication error occurs
proc closeport { } {

catch {device unlock}

catch {close device}

# Funzione di scrittura dell ""Instruction e Data Register”

#
proc set IR {JTAG cmd sock} {
variable x

openport
device lock —timeout 10000

# La stringa deve essere formattata come <IR DR>, esempio: <20 0x0040A1>
# Occorre quindi separare i campi

# Calocolo la lunghezza totale
set len [string length $JTAG cmd]

# Determino dove finisce il primo valore e dove comincia il secondo
set idx [string wordend $JTAG cmd 0]

set wl_end [expr $idx—1]

set w2 begin [expr $idx+3]

# Determino il comando Instruction Register: non serve conoscere la dimensione
set IR_cmd [string range $JTAG_cmd 0 $wl_end]
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#determino il comando Data Register: devo calcolare anche la lunghezza
set DR_cmd [string range $JTAG_cmd $w2_begin $len |
set DR len [expr [string length $DR cmd]| 4]

device virtual ir shift —instance index 0 —ir value $IR cmd —no captured ir value
set x [device virtual dr shift —dr value $DR cmd —instance index 0 —length $DR len —value in hex]

puts $sock $x

closeport

TCP/IP Server
#Code Dervied from Tcl Developer Exzchange — http://www.tcl.tk/about/netserver.himl

proc Start Server {port} {
set s [socket —server ConnAccept $port |
puts "Started_Socket_Server_on_port_—_$port"
vwait forever

}

proc ConnAccept {sock addr port} {
global conn

puts "Accept_$sock_from_$addr_port_$port"
set conn(addr,$sock) [list $addr $port]

fconfigure $sock —buffering line
fileevent $sock readable [list IncomingData $sock]

puts $sock "\nRichiesta_comandi_esadecimali_<IR>_<DR>"

proc IncomingData {sock} {
global conn

# Check end of file or abnormal connection drop,
# then write the data to the vJTAG

if {[eof $sock] || [catch {gets $sock line}]|} {
close $sock

puts "Close_$conn(addr,$sock)"

unset conn(addr,$sock)

} else {

#Before the connection is closed we get an emtpy data transmission.
#Let’s check for it and trap it
set data len [string length §line]
if {$data len != "0"} then {
set IR S$line $sock
}

}

#Start this Server at Port 2540
Start _Server 2540

Per quanto riguarda Qt, il programma é relativamente lungo e quindi non verra riportato, ma sara distribuito
con i sergenti degli esempi; di fatto non fa altro che inviare una stringa formattata in due numeri: il primo a

base decimale come comando IR, il secondo a base esadecimale nel formato “Ox...”. Sard poi lo script TCL a
togliere cid che non serve.

A questo punto avviare server e client come segue:
e Avviare una shell e spostarsi nella directory dei sorgenti
e eseguire il comando: quartus_stp -t TCL_Server vJTAG Test.tcl

o Per il client eseguire da QT Creator o direttamente dalla directory dei sorgenti il programma vJTAG
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A questo punto cliccando sul pulsante “Connect” dell’interfaccia Qt si trovera una situazione simile a quella
riportata in figura 5.4. Il server TCL, come si vede, ha accettato la connessione dal client.

/Documenti/Programmazione,/FP

Connected to localhost on port 56077
TDO:
Richiesta comandi esadecimali <IR> <DR=

ter [2

300D)

| cnman*lReDR devono esgfire inviaki enframbi. e RREt

IR deve essere in base 10, maftre DR in base 16 (0x)
- C d: IRDR * 15 0x55 Send Dat:
& . entifProgrammazione/FPGANERILOG_examples/VirtualUTAG 02 : quartus_stp R - = Ear Loxd

Figura 5.4: Virtual JTAG - Connessione Clietn/Server

Il programma Qt é generico per inviare un qualunque dato di qualunque lunghezza. Per come é concepito
il programma in FPGA occorre inviare un numero a 8 bit sia in IR che in DR. Facendolo, i led si dovrebbero
accendere rappresentando il numero di IR. Tenendo premuto su KEY1 i led si illumineranno rappresentando il
registro DR. Schiacciando poi qualche volta KEYO0 e reinviando un dato al’FPGA si vedra che i dati incrementati
dalla pressione di KEYO verranno letti dall’interfaccia Qt come rappresentato in figura 5.5.

Connected to localhost an port 56092 Connected to localhost on port 56092

TDO: TDO:
Richiesta comandi esadecimali <IR= <DR= Richiesta comandi esadecimali <IR= <DR>

Send: 15 0x55 len: 8 Send: 15 0x55 len: 8
TDO: 00 TDO: 00

Send: 200 0x05 len: 9 Send: 200 0x05 len: 9
TDO: 00 TDO: 00

Send: 127 0xA0 len: 9
TDO: 01

Send: 0 0x99  len: 7
TDO: 07

Disconnect

IR deve essere in base 10, meftre DR in base 16 (0:x) IR deve essere in base 10. mg@tre DR in base 16 (0x)

Command: IRDR  * 200 Dx05 Send Data Command: IRDR * 0 Dx99 Send Data

Icomal‘MIReDRde\mnoes e inviati enframbi. IcomaMIReDRde\mnoes e inviaki enframbi. Di
£ b isconnect

Figura 5.5: Virtual JTAG - Interfaccia Qt
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